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NOTE 
As of 13th January 2010 the changes are listed in Latest-Change-First sequence, within 

versions. 
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Version 1.6.3 – 24th June 2010 

Image Viewer 

1. 24th June – Now the Screen Capture image also has an EXIF preview image 
imbedded. 

2. 24th June – Improved the “Save a Copy for Emailing” process. Now it is faster, 
creates a better quality image, has an EXIF preview image imbedded, and works 
correctly with non-autorotated images. 
 

3. 20th June – Added a new dialog to enable adjustment of Color Fringing and CA. 
4. 20th June – Added menu “Adjust Image or Selection � Color Fringing and CA…”. 

 
5. 9th June – Updated the Adobe DNG Converter sub-application to version 6.1. 
6. 9th June – Added the “Image � Adjust Image or Selection � Reduce Shadow 

Speckling” menu option. This option applies a filter to reduce light coloured pixels 
from shadows. 

7. 9th June – Added support for the following Digital Camera RAW models: 
a. Canon EOS 550D 
b. Canon Digital Rebel T2i 
c. Casio EX-Z1050  
d. Fuji HS10 
e. Fuji HS11 
f. Samsung WB550 
g. Samsung NX10  
h. Sony NEX-3 
i. Sony NEX-5 

8. Added menu “Image � Rotate or Flip � From Drawn Angle with Crop…”, which 
displays the Rotate from Drawn Angle dialog, then crops the triangular non-image 
edge areas after rotation. 

9. Added a “Save a Copy for Emailing…” button to the toolbar. 
10. Added a “Rotate from Drawn Angle…” button to the toolbar. 

File Manager 

1. 20th June – Added menu “Viewers � Installed Applications Viewer…”. 
2. 20th June – Added a viewer window that displays all the applications installed in the 

pc. It also allows the user to uninstall the application, with a double-strength 
warning displayed first, of course! 

3. 20th June – Added menu “Viewers � Shared DLL Viewer…”. 
4. 20th June – Added a viewer window that displays all the shared DLL’s or libraries in 

the pc. It indicates whether the DLL is used once or more, or if the DLL actually 
exists in the file system. Double-clicking the DLL opens the folder where it is stored. 
 

5. 9th June – Split menu “Managers” into 2 primary menus called “Images” and 
“Files”. 

6. 9th June – Removed the “Managers” primary menu.  
7. 9th June – Added a new “Images” primary menu containing sub-menus: 

a. Create Contact Sheets from Images… 
b. Create Web Gallery from Images… 
c. Create AVI File from Images… 
d. Batch Convert Images… 
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e. Change All Image File CREATED Dates to EXIF Dates… 
f. Change Selected Image File CREATED Dates to EXIF Dates… 
g. Change All Image File CREATED & MODIFIED Dates to EXIF Dates… 
h. Change Selected Image File CREATED & MODIFIED Dates to EXIF 

Dates… 
i. Rename Image Files using EXIF Values… 
j. Convert RAW Images to Adobe DNG format… 
k. Copy Images to the iTunes folder… 

8. 9th June – Added a new “Files” primary menu containing options: 
a. Rename Multiple Files… 
b. Clear Internet Explorer Cache… 
c. Clear Work Files… 
d. Change File Properties… 
e. Change File Associations… 
f. FTP Files to/from a Remote Site… 

9. 9th June – Added menu “Images � Copy Images to the iTunes folder…”, as above 
in blue. 

10. 9th June – Added a new dialog to enable the copying of images from the current 
Xplorplus File List to a designated iTunes folder or subfolder. All or Selected 
Images can be copied as is, or downsized and/or reformatted (into JPEGs), into the 
destination folder. 
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Version 1.6.2 – 9th May 2010 

Image Viewer 

11. 9th May – Updated the Adobe DNG Converter sub-application to version 5.7. 
12. 9th May – Added the ability to change the EXIF Software field in the “Edit EXIF 

Camera Fields” dialog. 
13. 9th May – Added the “Image � Change Perspective, Shape…” menu. 
14. 9th May – Added the “Change Perspective, Shape” dialog. This dialog provides the 

user with a way to change the image perspective or shape by adjusting any or all of 
the image corners up, down, left, and right. 

15. 9th May – Added the “Image � Adjust Image or Selection � UnSharp Mask…” 
menu. 

16. 9th May – Added the “UnSharp Mask” dialog. This dialog effectively “sharpens” the 
image by highlighting edges. 

17. 9th May – Added the “Image � Adjust Image or Selection � Reduce Speckling” 
menu option. This option applies a series of filters to reduce light coloured pixels 
from shadows, and dark coloured pixels from light areas. 

18. 9th May – Added the “Image � Convert to Black and White � Threshold – Local…” 
menu. 

19. 9th May – Added the “Local Threshold” dialog for just one more way to convert an 
image to Black and White, using a Mean, Mean-Min-Max, or Median algorithm. 

Batch Conversion 

1. 9th May – Improved the way controls are enabled for use after the correct steps 
have been followed. 

2. 9th May – Added 7000 and 8000 pixels to the New Size selection drop-down list to 
cater for larger images. 

File Manager 

11. 9th May – Now the System Information dialog shows the installed Vista and 
Windows 7 version names accurately, for example: Vista Ultimate, or Windows 7 
Home Edition. 
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Version 1.6.1 – 24th February 2010 

Image Viewer 

3. 24th Feb – Updated the Adobe DNG Converter sub-application to version 5.6. 
4. 24th Feb – Now the RGB Color Levels dialog can adjust 6 colors. The 3 new color 

adjustments are for Yellow, Cyan, and Magenta. The dialog has also been 
simplified by removal of 3 buttons per adjuster, a total of 21 buttons, without loss of 
features. 

5. 24th Feb – Now the RGB White Balance dialog can adjust 6 colors. The 3 new color 
adjustments are for Yellow, Cyan, and Magenta. The dialog has also been 
simplified by removal of 3 buttons per adjuster, a total of 21 buttons, without loss of 
features. 

6. 24th Feb – Changed the Auto-Display Images dialog button captions to read: First, 
Last, Previous, and Next. 

7. 24th Feb – Added “Edit � Edit EXIF Camera Fields” menu option. 
8. 24th Feb – Added an Edit EXIF Camera Fields dialog that allows modification of the 

Camera Make and Model EXIF fields. 
9. 13th Jan – Added Camera RAW support for 7 models of camera, including:  

a. Canon EOS 1D Mark IV 
b. Canon PowerShot G11 
c. Canon PowerShot S90 
d. Casio EX-Z750 
e. Fujifilm FinePix SX200EXR 
f. Pentax K-x 
g. Sony DSLR-A550 

2009 
10. 29th Nov – Now the “Compare to Original” and Compare to Another” dialogs open 

with the “Fit to Window” checkbox set as when previously closed. 
11. 29th Nov – Now EXIF values that are not recorded by a camera, are displayed as 

“Not Recorded” instead of a less meaningful negative value. 
 



 XplorPlus Changes 

Author and Copyright: Raysoft Systems Page 11 of 64 Date: 24 June 2010 

Version 1.5.9 – 23rd November 2009 

File Manager 

2008: 

1. 13th Nov – Added menu “Managers � FTP Files to/from a Remote Site…”.  
Selecting this option opens the FTP Client window, which lets you transfer files to 
and/or from Web Sites or FTP Sites. 

2. 13th Nov – Added toolbar button “FTP Client…”.  Selecting this option opens the 
FTP Client window, which lets you transfer files to and/or from Web Sites or FTP 
Sites. 

2009: 

12. 23rd Nov – Added ISO Sensitivity EXIF field to the “Rename Image Files using 
EXIF Values” dialog. 

13. 23rd Nov – Added menu option “Managers � Change All Image File CREATE & 
MODIFIED Dates to EXIF Dates. 

14. 23rd Nov – Added menu option “Managers � Change Selected Image File 
CREATE & MODIFIED Dates to EXIF Dates. 

15. 23rd Nov – Updated the link to Adobe DNG Converter, to version 5.5. 

FTP Client (New) 

1. 13th Nov – Added an FTP Client window, which lets you transfer files to and/or from 
Web or FTP Sites. 

Image Viewer 

2008: 

1. 13th Nov – Improved GIF loading speed. 
2. 13th Nov – Added filtered Re-sampling for 8 bit gray scale images. 
3. 13th Nov – Enhanced quality of Rotation without Anti-Aliasing. 
4. 13th Nov – Restored default JPEG_DCT = JPEG_ISLOW. 
5. 13th Nov – Added support for EXIF from Photoshop CS3. 
6. 13th Nov – Enhanced JPEG quality when Quality is 100. 
7. 13th Nov – Improved the speed of Re-sampling routines (like Triangle, etc.) and 

filtered display. 
8. 13th Nov – Added support for LZW compressed TIFF with inverted fill order. 
9. 13th Nov – Now selection of objects with Pen Width > 1 works better. 
10. 13th Nov – Now supports RAW files (real RAW, not Camera RAW!). 
11. 13th Nov – Added support for planar CMYK (8 bit) TIFF. 
12. 13th Nov – Now the preview dialog is correctly displayed under Vista. 

2009: 

1. 23rd Nov – Added Camera RAW support for 1 make and 47 models of camera, 
including: 

a. Canon EOS 5D Mark II 
b. Canon EOS 7D 
c. Canon EOS 500D 
d. Canon PowerShot G10 
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e. Canon PowerShot G11 
f. Fujifilm FinePix S100FS 
g. Fujifilm FinePix S6000fd 
h. Fujifilm IS-1 
i. Hasselblad V96C 
j. Leaf AFi 7 
k. Leica D-LUX 4 
l. Nikon D3X 
m. Nikon D300s 
n. Nikon D3000 
o. Nikon D5000 
p. Nokia N95 
q. Olympus E-30 
r. Olympus E-P1 (Pen) 
s. Panasonic DMC-G1 
t. Pentax K-7 
u. Phase One P 45+ 
v. Sony DSLR-A330 
w. Sony DSLR-A380 
x. Sony DSLR-A850 

2. 23rd Nov – Added ISO Sensitivity EXIF field to Image Properties display. 
3. 23rd Nov – Added a Color Temperature image adjustment dialog. 
4. 23rd Nov – Added Color Temperature Presets to the RGB Color Levels dialog. 
5. 23rd Nov – Added Color Temperature Effect Presets to the RGB Channel Intensity 

dialog. 
6. 23rd Nov – Added Color Temperature Effect Presets to the RGB White Balance 

dialog. 
7. 23rd Nov – Added menu option “File � Change Created & Modified Date to Date 

Taken". 
8. 23rd Nov – Added menu option “Image � Adjust � Color Temperature". 

Batch Conversion 

2009: 

1. 23rd Nov – Added “Auto White Balance” option to the Image Adjustments dialog. 
2. 23rd Nov – Now Remove Color Cast and Convert to Gray are performed first in the 

Batch Conversion, before everything else. 
 

Thumb Viewer 

1. 13th Nov – Added support for the preview of IEV, ALL and LYR image formats. 
2. 13th Nov – Now it is possible to load/save the ICO image format. 
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Version 1.5.8 – 31st October 2008 

File Manager 

1. 31st Oct – Fixed a bug that caused Xplorplus to hang if Adobe’s DNG Converter 
application had been opened. 

2. 29th Oct – Added menu “Managers � Convert RAW Images to Adobe DNG 
format…”.  Selecting this option opens Adobe’s DNG Converter application, using 
the currently active Xplorplus file-list path as the “Select the Images to Convert…” 
folder. 

Image Viewer 

3. 15th Oct – Now supports Panasonic LX3, and FZ28, Nikons D90 and P6000, 
Canon EOS 50D, and Sony A900 RAW-type images. 

4. 23rd Sep – Fixed a bug in the RGB Channel Intensity dialog, which caused 
incorrect values to be recalled. 

5. 23rd Sep – Fixed a bug in the RGB Color Levels dialog, which caused incorrect 
values to be recalled. 

6. 21st Sep – Fixed a bug that caused the sampling image to display at the wrong size 
when an Image Adjustment dialog is opened. 

7. 19th Sep – Now the SpeedKeys option uses Median Sharpening. 
8. 17th Sep – Fixed a memory leak which affected reading of all RAW-type images. 
9. 17th Sep – Now supports Kodak C603, Nikon D700, Canon EOS 1000D, Canon 

PowerShot SD300, and Olympus E-520 RAW-type images. 
10. 17th Sep – Fixed a bug in "Cut Selection - Paste to Selection" processing, with 

"Selection Effects" checked. 
11. 23rd Aug – Now RAW image types are read about 400% or 4 times faster than 

before. 
12. 23rd Aug – Fixed a bug in the “Noise…” and “Sharpen…” Median filters which, 

under some circumstances, left a black line down the right-hand side of the image. 
13. 23rd Aug – Increased the speed of the Median filter processes by 100%, so they 

are now twice as quick as before. 
14. 10th Aug– Changed menu option “Image � Adjust Image or Selection � 

Exposure…” to “Image � Adjust Image or Selection � Exposure, Offset, and 
Luminance…”, because an extra adjustment has been put on the dialog. 

15. 10th Aug – Added an additional Luminance adjustment to the “Exposure, Offset, 
Gamma, and (now) Luminance” dialog. 

16. 19th Jul – Now the Image Layer Tool writes to the log when the changes are 
applied to the image. 

17. 19th Jul – Fixed a bug in the Layer Transparency adjuster that caused it to become 
unstable. 

18. 19th Jul – Improved the “Auto Sharpen” results. 
19. 17th Jul – Fixed a bug in the “Contrast and Brightness” dialog that caused the slider 

to have no effect. 
20. 12th Jul – Added menu “Image � Compare to Another…”.  This option allows you 

to select another image to compare to the one currently being edited.  This is 
helpful to make decisions about the current image edits by placing the images side-
by-side.  Both images are sizeable and scrollable, either independently or in-sync. 

21. 12th Jul – Added menu “Image � Adjust with Layers…”. This option allows you to 
use image adjustment layers to brighten, darken, and lighten, and more, to the 
image. 
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22. 12th Jul – Added menu “Image � Reduce Gamut”. This option is similar to 
changing the color space from <AdobeRGB1998> to <sRGB>, reducing the gamut. 

23. 12th Jul – Added menu “Image � Increase Gamut”. This option is similar to 
changing the color space from <sRGB> to <AdobeRGB1998>, increasing the 
gamut. 

24. 12th Jul – Added menu “Image � Adjust Image or Selection � Channel 
Intensity…”.   This option allows you to adjust Red, Green, and Blue colors 
independently, as well as the intensity curve for all the colors. 

25. 12th Jul – Added menu “Image � Adjust Image or Selection � Exposure…”.   This 
option allows you to adjust the image the equivalent on a camera of from -3.00 to 
+3.00 F/stops.  There is also an Offset control to lighten and darken the darker 
shades, and a Gamma control to adjust the overall gamma lightness of the image.  
This control is meant to emulate the equivalent Photoshop CS2 control, plus 
improve on the usefulness and accuracy of the Offset and Gamma control, 
respectively. 

26. 12th Jul – Added menu “Image � Adjust Image or Selection � Color Balance…”.   
This option allows you to adjust 5 levels of color independently, with 7 color biases 
per channel. 

27. 12th Jul – Added a ColorBar on all the Image Adjustment dialogs that previously 
used Checkboxes to select the combinations of Red, Green, and Blue channels 
influencing the image change bias.  The ColorBar improves on the ergonomics of 
selecting any of the 7 possible color combinations. 

28. 12th Jul – Added menu “Settings � Load PSD with Layers (Merged)”.  This option 
allows you to choose whether or not to view, edit, or print a PSD image using the 
layers created in Adobe Photoshop. The layers are merged as the image is loaded, 
so saving the image means that extra layers become the background layer. 

Batch Conversion 

1. 29th Oct – Now the “Input Type” and “Output Type” dropdown-list boxes are sorted. 
2. 19th Sep – Now the Batch Conversion option uses Median Sharpening. 

Snapshot Viewer 

1. 25th May – Made various improvements to the way it works. 

Archive Viewer 

1. 15th Oct – Fixed a bug in the Archive Viewer file details that caused the date to be 
displayed incorrectly. 
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Version 1.5.7 – 25th May 2008 

File Manager 

1. 25th Apr – Added menu “Managers � Rename Image Files using EXIF Values…”. 
This option allows you to create a filename using up to 10 EXIF tag values, plus the 
original file name. 

2. 25th Apr – Added menu “Tools � Join Text Files…”.  This option opens a dialog 
that lets you join all, or a selection of, text files from a folder to create 1 file that 
contains them all separated with indicators.  This feature is very helpful for sending 
Logs, Ini’s, or source code, to another machine.  Use the new menu option 
“Options � Un-Join Joined Text Files…” in File Viewer to split them up again. 

3. 25th May – Added menu “Viewers � Folder Images Snapshot Viewer…”.  This 
viewer is similar to the Thumbnail Viewer in that it displays thumb-sized images of 
all the compatible images in a folder, but most importantly it also creates a 
thumbnail database file in every folder where it is used.  This new approach speeds 
up the displaying of the thumb-images.  It also displays a list of all the folders where 
a database file exists, which can be used to navigate to your image folders. 

4. 25th May – Added 2 toolbar icon buttons: 1 to Open the Snapshot Viewer, and 1 to 
Open the Web Gallery Creator. 

Image Viewer 

1. 25th Apr – Added menu “File � Save as Filename with EXIF Details…”.  This 
option lets you use up to 10 EXIF tag values in the File Name. 

2. 25th Apr – Added menu “File � Change Create Date to Date Taken…”.  Often 
software changes the Create Date on the file when copying it from the camera.  
This option lets you correct this problem by replacing the Date and Time from the 
EXIF tag data. 

3. 25th Apr – Added menu “Image � Adjust Image or Selection � Radial 
Distortion…”.  This option lets you correct Barrel and Pin-Cushion distortion in an 
image, as well as any Chromatic Aberration. 

4. 25th Apr – Added menu “Image � Adjust Image or Selection � Noise…”.  This 
option lets you reduce digital camera noise in any image, using an adjustable 
Median Filter. 

5. 25th Apr – Added menu “Image � Adjust Image or Selection � Sharpness…”.  
This option lets you increase the sharpness of any image, using an adjustable 
Median Filter. 

6. 25th Apr – Changed menu “Image � Adjust Image or Selection � Contrast and 
Brightness…” to “Image � Adjust Image or Selection � Contrast, Brightness, and 
Gamma…”. 

7. 25th Apr – Removed menu “Image � Adjust Image or Selection � Gamma…”.  
This option has been added to the Contrast and Brightness dialog. 

8. 25th Apr – Removed menu “Image � Adjust Image or Selection � Histogram 
Equalisation…”.  This was always a duplication of a feature. 

9. 25th Apr – Added menu “Image � Convert Image or Selection to � Wallis Filter 
Effects…”.  The Wallis Filter adjusts Brightness values in local areas so that the 
local Mean and Standard Deviation match user-specified target values. This 
enhancement produces good local contrast throughout the image, while reducing 
the overall contrast between bright and dark areas.  The Wallis Filter dialog can 
also be used with color images to create some interesting contrast and edge 
enhancement effects. 
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10. 25th Apr – Added menu “Image � Reduce Noise”. 
11. 25th Apr – Added menu “Image � Change the Number of Colors � Black and 

White � Edge Detect Median…”.  Another way of converting a color image to Black 
and White using a Median Filter. 

File Viewer 

1. 25th Apr – Added menu “Options � Un-Join Joined Text Files…”.  Xplorplus Joined 
files can be split back to their original state using this option. 

Snapshot Viewer (New) 

1. 25th May – Added Form Images Snapshot Viewer. 
 
This viewer is similar to the Thumbnail Viewer, in that it displays thumb-sized 
images of all the compatible images in a folder, but what makes it different is that it 
also creates a thumbnail database file in every folder where it is used, which is read 
the next time instead of the images.  This new approach speeds up the subsequent 
displaying of the thumb-images.  It also remembers and displays a list of all the 
folders where a database (snapshot) file exists, which can be used to navigate to 
your image folders.  To add a new snapshot, click on a folder in the Xplorplus 
Drive/Folder list (the leftmost list). If the folder contains images they will be 
displayed in the Snapshot Viewer and the folder will be added to the left list of the 
Snapshot Viewer, too.  Once a snapshot has been added, the thumb-image display 
becomes much quicker the next time.  To navigate between the image folders in 
the Snapshot Viewer, just click on the folders in the list, if the folder selected 
contains images they will be displayed.  At any time, you can Refresh all the folders 
in the list, or Refresh/Delete the currently displayed Snapshot.  It is also possible to 
Exclude certain image types, like Cursors and Icons, etc.  Snapshot Viewer 
automatically updates the snapshot file with if 1 or more images are added or 
deleted. 
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Version 1.5.6 – 26th February 2008 

File Manager 

1. 1st Dec – Now you can use the “Email as Attachment(s)…” file-list context menu 
option, even if your email client is not Outlook Express. 

2. 16th Jan – Added “Managers � Change All Image File Create Dates to EXIF 
Dates” menu option.  This option causes the File Creation Dates for all the image 
files in the folder to be changed to the Date/Time Picture Taken as held in the EXIF 
information. 

3. 16th Jan – Added “Managers � Change Selected Image File Create Dates to EXIF 
Dates” menu option.  This option causes the File Creation Dates for all the selected 
image files in the folder to be changed to the Date/Time Picture Taken as held in 
the EXIF information. 

4. 26th Feb – Fixed a bug in the File Search engine, which caused the Case Sensitive 
Text searches to fail. 

Image Viewer 

1. 1st Dec – Fixed a bug in the Object Properties dialog, now the Memo background 
color is correct. 

2. 1st Dec – Added “File � Clear Undo On Save” menu, which when checked clears 
the undo buffer during a save operation, so the image changes can no longer be 
reversed. 

3. 1st Dec – Added “Image � Convert Image or Selection to � Pencil Drawing � 
Light” menu. 

4. 1st Dec – Added “Image � Convert Image or Selection to � Pencil Drawing � 
Dark” menu. 

5. 1st Dec – Added “Image � Reduce Noise” menu, which reduces the light speckling 
often found in digital images taken at a high ISO speed. 

6. 1st Dec – Added “Image � Black and White � Edge Detect Sobel” menu. 

7. 1st Dec – Added “Image � Resample…” menu, which lets you smooth the image 
from a selection of algorithms. 

8. 1st Dec – Added a Resample Options dialog box, displayed from the menu option in 
the previous point. 

9. 1st Dec – Removed the “Image � Auto Resample” menu 

10. 1st Dec – Now Angle Objects are editable. 

11. 1st Dec – Now the Angle used in the “Rotate from Drawn Angle” process can be 
adjusted after it is drawn. 

12. 1st Dec – Fixed a memory leak in vectorial objects handling. 

13. 1st Dec – Fixed the Open dialog problems, which occur when viewing vectorial 
objects and layers. 

14. 1st Dec – Fixed a bug reading PSD thumbnails. 

15. 1st Dec – EXIF GPS Version is now saved correctly. 
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16. 1st Dec – Fixed a memory leak loading JPEG/TIFF with GPS information. 

17. 1st Dec – Fixed a memory leak reading Canon RAW CRW files. 

18. 5th Dec – Now the EXIF Unique Identity field is displayed in the properties, if 
detected in the image. 

19. 5th Dec – Now supports 290 RAW Camera models, 10 more, including the Nikon 
D3, and D300, Sony DSLR A700, and the Canon 40D and 1Ds Mark III. 

20. 9th Dec – Fixed a bug in the RAW Profile settings. 

21. 9th Dec – Added a Green Multiplier adjuster to the RAW Profile Settings dialog. 

22. 12th Dec – Now, when the thumb images are displayed, the selected thumb has a 
red border around it. 

23. 15th Jan – Added “Thumbs � Selected… Change Create Dates to EXIF Date” 
menu option.  This option causes the File Creation Dates for all the selected 
thumbs to be changed to the Date/Time Picture Taken as held in the EXIF 
information. 

24. 26th Feb – Added “Tools � Generate Charts � Lens Distortion Chart 4:3” set of 
menus.  The “4:3” represents 1 of 6 aspect ratios that Xplorplus can generate as 
requested.  Each aspect ratio suits a particular camera sensor type, or film size. 

Thumb Viewer 

1. 1st Dec – Changed the Thumb selection highlighting method. 

2. 15th Jan – Added “File � Change Create Date to Date Taken” menu option.  This 
option causes the File Creation Date to be changed to the Date/Time Picture Taken 
as held in the EXIF information. 

Image Batch Conversion 

1. 1st Dec – Added “Fit Within” image resize option, which scales an image to a size 
that completely fits within an imaginary rectangle with the specified dimensions.  
This is useful for preparing images for projection or to put in Web Galleries. 

2. 11th Dec – Fixed a bug in the Image Adjustments option dialog that caused the 
White Balance adjustment to not be applied to the image sometimes. 

Change Properties 

1. 1st Dec – Fixed a bug that prevented the Date and Time from changing properly 
under Vista. 
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Version 1.5.5 – 11th July 2007 

File Manager 

1. 11th Apr – Added “Options � Configuration Settings” menu. 

2. 11th Apr – Moved the “Options � Save Settings Now” menu to the “Options � 
Configuration Settings � Save Settings Now” menu. 

3. 11th Apr – Moved the “Options � Save Settings on Exit” menu to the “Options � 
Configuration Settings � Save on Exit” menu. 

4. 11th Apr – Added “Options � Configuration Settings � Export Now…” menu 
option.  Exporting the Xplorplus Settings is useful just in case an Error occurs in the 
Windows Registry and the error causes a loss of the Xplorplus Settings.  If this 
happens they can be reloaded from the Exported File later. 

5. 11th Apr – Added “Options � Configuration Settings � Reload Exported Now…” 
menu option. Reloading the Previously Exported Xplorplus Settings RESETS ALL 
the Settings to be the SAME as they were when last Exported, and should ONLY 
be done if there is a Registry Error. 

6. 11th Apr – Added “Options � Configuration Settings � Export On Exit…” menu.  
This option silently Exports the Xplorplus Settings to a file when it is closed. 

7. 23rd May – Now Xplorplus is Vista tested. 

8. 23rd May – Improved the speed at which the Folder ‘+’ signs are resolved for 
remote (mapped network share) folders. 

9. 1st Jun – Added the ability to play multiple selected media files, like a playlist.  
Selecting more than one WAV, AVI, WMV, RMI, MID, MP3, etc. will cause 
Xplorplus to play all the selections, starting with the last one selected, when “Play 
Media” is chosen from the context-menu, or the Media Player is opened.  Multiple 
JPG, BMP, or GIF files can also be viewed.  Pressing ‘STOP’ will cause the next 
selected image to display. 

10. 2nd Jun – Fixed a bug that occurred in Windows Vista when the Xplorplus Registry 
entries are corrupted for some reason, and Xplorplus is configured to Automatically 
Restore those entries when started. 

Web Gallery 

1. 14th Apr – Improved the image-resizing algorithm. 

2. 14th Apr – Fixed subtle inconsistencies in the Web Templates. 

3. 16th Apr – Added 8 new image size options. 

4. 23rd May – Now Clicking the Left-Mouse on the Image for Styles 1 to 5 will Toggle 
between STOP and NEXT, if Auto-Display is ON. 

Rename Multiple Files 

1. 23rd May – Fixed a bug that caused X+ to crash when renaming a file or folder 
without an extension. 

2. 11th Jul – Fixed a bug that caused incorrect trimming of characters from the 
existing filename component in a rename operation.  
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FlushIE 

1. 23rd May – Fixed a bug that caused X+ to crash when wiping work files with 
FlushIE, in unusual situations. 

2. 11th Jul – Now Windows Vista ‘Low’ folders are also wiped.  ‘Low’ Cookie, History 
and Temporary Internet folders are used when ‘User Account Control’ is turned on 
(default setting). 

Image Contact Sheet Manager 

3. 1st Jun – Added the option to repeat a Single image multiple times on a page. 

4. 3rd Jun – Added an option to “Hide Captions” under each image. 

5. 3rd Jun – Now there are more “Watermark” options. 

Media Player 

1. 2nd Jun – Added the ability to play multiple selected media files, like a playlist.  
Selecting more than one WAV, AVI, WMV, RMI, MID, MP3, etc. will cause 
Xplorplus to play all the selections, starting with the last one selected, when the 
Media Player is opened.  Multiple JPG, BMP, or GIF files can also be viewed.  
Pressing “STOP” will cause the next selected image to display. 

Image Viewer 

1. 10th Jun – Improved the “Pause / Play” feature of the Auto-Display dialog. 

2. 11th Jun – Added 2 toolbar buttons, “Rotate 90 degrees” and “Rotate –90 degrees”. 

Thumbnail Viewer 

1. 10th Jun – Added common Widescreen display sizes to the “Slide Show � Slide 
Size” menu option. 
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Version 1.5.4 – 8th April 2007 

File Manager 

1. 20th Jan – Now Xplorplus displays properly when the user selects a “High Contrast” 
Windows Desktop theme. 

2. 26th Jan – Added menu option “Tools � Capture Screen…”.  This option was 
previously only available from the Image Viewer Tools menu. 

3. 4th Feb – Added menu option “Options � Auto-Select New Drives”.  This differs 
from the “Auto-Detect Floppy Drives” because it affects all Plug-and-Play or Hot 
Swappable drives, such as USB Flash drives. 

4. 18th Feb – Added “Tools � Registry Editor” menu option. 

5. 18th Feb – Added “Managers � Create Web Gallery from Images…” menu option. 

6. 19th Feb – Now the Desktop and Start Menu icon labels show Xplorplus version 
1.5.4, not 1.5.3. 

7. 3rd Mar – Now only the Active File List is refreshed if it is displaying the contents of 
a Plug & Play drive when it is removed.  Previously both the Active and Passive file 
lists were affected by this action. 

8. 3rd Apr – Now, in the ‘Email as Attachment(s)’ dialog, in the ‘X+ Account’ option, it 
is now possible to type the letter ‘@’ in the ‘User Name’ text box. 

9. 5th Apr – Added a new ‘View IE Caches’ button to the ‘Clear Work Files’ dialog, 
which opens the ‘IE Cache Manager’ dialog. 

Registry Editor 

1. 18th Feb – Added a new independent Registry Editor application.  Similar to the 
Microsoft supplied application except that it allows the copying of multiple keys at 
one time, and displays “Keys of Interest” with a description of their use.  Keys of 
Interest can also be cleared in groups to save time. 

Web Gallery 

2. 18th Feb – Added a new Web Gallery creation window.  The new window allows the 
selection of images from multiple folders, and selection of various gallery styles.  
Fonts, captions, colors and image sizes are all customizable. 

3. 22nd Mar – Now the images and thumbnails created for the Web Gallery have their 
EXIF preview image orientated correctly, and are auto-oriented properly when 
opened in an image viewing application. 

4. 22nd Mar – Added clearer instructions on how to specify the Output Folder to 
contain the Web Gallery. 

5. 25th Mar – Now the Image Comment is saved so it can be used the next time the 
same image is used to create a Web Gallery. 

6. 29th Mar – Now the Image Comment is saved in the JPEG EXIF ‘Image 
Description’ field if it exists, otherwise a ‘~xnote’ file is created. 
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7. 4th Apr – Now there is a “Back to Gallery Index” link on each gallery web page, that 
when clicked returns the web user to the originating web page, from where the slide 
show was opened. 

8. 4th Apr – Now the automatic image refresh reads the cached image if available, to 
save excessive use of the bandwidth by continually accessing the server for the 
images. 

9. 8th Apr – Added a new ‘View the Galleries Index Page…’ button on the ‘Style…’ 
panel.  The button opens a web page on the Xplorplus website, containing links to 
8 galleries, 1 example for each style. 

Thumbnail Viewer 

1. 19th Feb – Added “Tools � Create a Web Gallery from Images…” menu option. 

Image Viewer 

1. 19th Feb – Added “Tools � Web Gallery maker…” menu option. 

2. 25th Feb – Added RAW support for 18 models of camera, including the new Nikon 
D40, Canon PowerShot Pro1, and Leicas D-LUX 3 and V-LUX 1. 

3. 26th Feb – Improved the color mapping for RAW format images. 

4. 29th Mar – Now menu ‘File � Print from Selection…’ works properly. 

5. 30th Mar – Added the ability to update the EXIF ‘Image Description’ field in the “Edit 
User EXIF fields” dialog. 

6. 30th Mar – Now, if any EXIF User fields are changed in a JPG, and the image is 
NOT changed, the fields are automatically saved to the EXIF header without 
prompting the user, or modifying the image. 
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Version 1.5.3 – 8th November 2006 

File Manager 

1. 7th Sept – Added “Tools � Sync or Set Date and Time…” menu option.  Use this 
option to Synchronise the System Date and Time to a Public Time Server, or 
manually set the System Date and Time using the Windows dialog. 

2. 7th Sept – Added “Synchronise or Set System Date and Time” dialog.  This dialog 
supplies a list of Public Time Servers to choose from in a drop-down list.  The 
selected Time Server can be used for synchronisation. 

3. 12th Sept – Added “Email as Attachment(s)…” menu option to the context-sensitive 
popup menu in the File List, if a file is right-clicked.  Displays an Email Client dialog 
to compose and send an email with all the selected files as attachments.  This 
menu option only appears if Outlook is, or has at one time, been installed, with an 
account. 

4. 12th Sept – Added “Send an Email with Selected Attachment(s)” dialog, opened as 
explained in the previous point. 

5. 12th Sept – Added “Select Contact(s)” dialog, from which to select “To/Cc/Bcc” 
recipients of the email. 

6. 12th Sept – Added the ability to ‘Add a New Contact’ to the “Select Contact(s)” from 
the Email Addresses dialog. 

7. 14th Sept – Added the ability to create an Xplorplus Specific Email Account.  This 
account is only required if you have an Outlook compatible email account from the 
ISP, but have NOT set it up in Outlook Express.  It does NOT work for Hotmail, 
gMail, Yahoo or any Web-based email accounts. 

8. 3rd Oct – Modified the way the 3 “All Users” Personal Folders are displayed in the 
drive list. 

9. 20th Oct – Now it is NOT possible to open the “Email as Attachments” dialog if 
there is no network connection.  

10. 25th Oct – Fixed a bug that caused folder icons on remote drives to not appear in 
the file list, when there were more than 70 sub-folders to show. 

Image Viewer 

1. 7th Sept – Added “Options � Show Thumb selector” menu option.  Use this option 
to Show/Hide a single column of Thumbs down the right-hand side of the Image 
Viewer, from which you can select an image to display in the Viewer. 

2. 7th Sept – Added RAW Format support for 2 new makes and 6 models of digital 
camera, including: 

• Leaf Cmost 

• Panasonic DMC-LX2 

• Sony DSLR-A100 (Alpha) 

• Pentax *ist DL2 

3. 13th Sept - Added RAW support for 3 new makes and 32 models of digital camera. 
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4. 14th Sept – Added an option to the “Save a Copy of the Image for Emailing” dialog, 
to email the copy immediately.  The caption on the new button is “Save & Email…”. 

5. 3rd Oct – Added a ‘Remove Redeye’ button to the Toolbar.  This button is only 
visible when a part of the image is selected. 

6. 20th Oct – Improved the Jpeg Lossless Rotation algorithm. 

7. 20th Oct – Added support for ZIP compression in TIFF images. 

8. 24th Oct – Added RAW Format support for 3 more models of digital cameras, 
including the Nikon D80. 

Quick System Viewer 

1. 3rd Oct – Improved the interface, and updated the Virtual Memory display to allow 
for VM of greater that 4 gigabytes. 

2. 4th Oct – Added Memory % Used, Virtual Memory % Used, and Page File % Used 
displays. 

3. 5th Oct – Added % Memory Load display. 

4. 5th Oct – Now the ‘Usage’ and ‘Load’ figures refresh every 500 milliseconds. 

5. 5th Oct – Added a checkbox option to keep the dialog on top of all other windows, 
to enable the monitoring of memory and CPU usage while working in other 
applications. 

Associations Manager 

1. 3rd Oct – Now the Change and Delete buttons are disabled if there are no 
associations in the list. 

2. 3rd Oct – Now the “Associations” search allows for special characters (i.e.: $, #, &, 
and etc) at the start of any file extension registry key. 

Font Viewer 

1. 3rd Oct – Improved the interface. 

FlushIE 

1. 8th Nov – Now FlushIE WIPES ALL files, not just the Index.dat files.  ‘Wiping’ files 
deletes them so that the filename and data cannot be recovered. 
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Version 1.5.2 – 24th August 2006 

File Manager 

1. 10th August – Added “Edit � Invert Displayed Extensions” menu option.  This 
menu is only available when a File Filter other than “*.*” is being used.  When 
selected, all displayed files are hidden and any previously hidden files are 
displayed.  When the file display is EXCLUDING filtered files (Inverted), the filter 
drop-down list shows as Red.  When it is INCLUDING the filtered files, it shows as 
Green. 

2. 17th August – Added “Favorites” menu.  Favorites are a list of folders that the user 
wants instant access to by clicking on the appropriate one in the menu. 

3. 17th August – Added “Favorites � Add to Favorites…” menu.  Clicking this menu 
while a folder is selected in either the Drive or Active File list, will add the Folder to 
the Favorites menu, giving instant access to the folder from the menu. 

4. 17th August – Added � Manage…” menu.  This menu option opens the “Manage 
Favorite Folders” dialog, which allows the user to Add, Delete, and Arrange the 
entries in the Favorite menu. 

5. 17th August – Added “Manage Favorite Folders” dialog.  This dialog allows the 
user to Add, Delete, or Arrange the entries in the Favorites menu. 

6. 17th August – Added “Add to Favorites” menu option to the context-sensitive pop-
up menu displayed when the right mouse button is clicked on a folder. 

7. 24th August – Now it is possible to use Ctrl-X, Ctrl-C, and Ctrl-V to Cut, Copy and 
Paste text for a Folder or File name, when Renaming it.  

Image Viewer 

1. 13th August – Fixed a bug in the “RGB White Balance” and “RGB Color Levels” 
dialogs that caused the sliders to jump to the wrong values in certain situations. 

2. 18th August – Moved menu “Options � Log Image Changes” to “Settings � Log 
Image Changes”. 

3. 18th August – Added menu “Settings � Log Image Changes � Enable”. 

4. 18th August – Added menu “Settings � Log Image Changes � Keep Undo Entries 
on Save”, to include or remove entries that are ‘Undone’ after being applied to the 
image. Removing the entries simplifies and rationalises the log.  The ‘Undone’ 
entries will still show in the Log Window until the image is saved. 

5. 22nd August – Now it is possible to save all compatible input image formats as PS 
(Postscript), EPS (Enhanced Postscript), and PDF (Adobe Portable Document 
Format).  

6. 24th August – Fixed a bug that caused the “Send to Recycle Bin” and “Delete 
Permanently” toolbar buttons to not work properly. 

Rename Multiple Files 

1. 13th August – Now there is no “Rename” button, the user must now press the 
“Preview and Rename” button to check the results before renaming. 
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Image Contact Sheet Manager 

1. 14th August – Added an option to “Print a Mark on Each Image”.  This lets you 
overlay either “SAMPLE” or “COPYRIGHT” on the middle of the image. 

2. 22nd August – Now the overlaid Image Mark is semi-transparent. 

Thumbnail Viewer 

1. 24th August – Fixed a bug that caused Xplorplus to terminate during a Slide Show 
if a Thumbnail Image exists but the actual file has been deleted. 
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Version 1.5.1 – 8th August 2006 

File Manager 

2. 19th July - Added “Help � Get the Latest Version…” menu option, which links to 
the Xplorplus Web Site. 

3. 20th July - Now the “Help � Contact Support…” email is addressed to 
mailto:support@xplorplus.com. 

4. 3rd August – Fixed a bug that caused Xplorplus to crash when the start-up folder is 
in the user profile folders, and the profile is corrupted then re-created with a 
different name by Windows, after restarting the machine. 

Rename Multiple Files 

1. 15th July - Fixed a bug that caused the Time component of the File Date to be 
omitted from the output filename sometimes, when requested. 

2. 18th July - Now it is possible to TRIM characters from the Start and/or End of the 
Old File Name if it is included in the New File Name. 

3. 19th July - Improved the Interface. 

4. 23rd July - Fixed a bug that allowed a decimal point be entered in the Sequential 
Number option. 

5. 23rd July - Fixed a bug that allowed NO numbers to exist in the Sequential 
Number option. 

Image Viewer 

1. Added 7 “Image � Rotate or Flip � JPEG Lossless Transform” menu options.  
These options are ONLY available if the image has NOT been changed, or all the 
changes have been UNDONE.  The difference between these and the standard 
rotate options is that the rotation or flip is done WITHOUT interpreting the displayed 
file image information; rather it uses an algorithm that avoids decompressing and 
recompressing the image.   
Options are:  

• Rotate +90,  

• Rotate 180,  

• Rotate -90,  

• Flip Horizontal,  

• Flip Vertical,  

• Transpose UL to LR (Upper Left Corner to Lower Right Corner), and  

• Transverse UR to LL (Upper Right Corner to Lower Left Corner). 

2. Updated EXIF properties display to make it easier to read. 

3. Added various EXIF properties, including “Auto-Rotated”, “Aspect” and “Digital 
Zoom”. 
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4. Now, when the EXIF Preview Image AND the Properties are displayed together, 
the Preview Image is ABOVE the Properties, not over the Main Image as before. 

5. Added a new Navigator sub-dialog, which displays a thumb-sized version of the 
entire image, and lets the user move around an image that is zoomed outside the 
visible window area, by moving a rectangle representing the area in view. 

6. Added “File � Auto-Orientate Page to Image” menu option, which when checked, 
detects whether the image is portrait or landscape, and sets the print page to suit. 

7. 21st July - Fixed a bug that sometimes caused a blank EXIF Preview area to show 
when the Properties are showing and the image has no Preview image. 

8. 23rd July - Fixed a bug in the "Selection � Build Selection Point-by-Point" menu 
option, that caused the wrong points to be selected under a particular set of 
circumstances. 

9. 23rd July - Fixed a bug that caused some menus to be available when the 
"Selection � Build Selection Point-by-Point" menu option was in use. 

10. 27th July – Added “Options � Auto-Display Folder Images…” menu option that 
initiates a display of the images in the selected folder in a pseudo-slideshow. 

11. 27th July – Added “Auto-Display Images” dialog that controls the direction and 
duration of the images displayed. 

12. 27th July – Moved the “File � Edit ???” sub-menus from the “File” menu to the 
“Edit” menu. 

13. 1st August – Fixed a bug that caused the buttons that should have INCreased 
Selection Feathering and Transparency, but actually DECreased the values. 

14. 3rd August – Fixed a bug that caused the RAW Profile Dialog to NOT undo the 
profile changes if Cancel was pressed. 

15. 3rd August – Now it is NOT possible to select the “Options � Auto-Rotate JPEGs 
and TIFFs” and “Options � Fast Read Camera RAW Images” menus, if the image 
has been changed. 

16. 4th August – Now it is also possible to remove any number of points during the 
“Selection � Build Selection Point-by-Point” process.  The number of selected 
points is also shown now to assist in determining points to remove. 

17. 5th August – Added “Object(s) � Save…” and “Object(s) � Load…” menus, so 
now it is possible to Save and Load back vectorial and bitmap objects in a 
proprietary file format with the extension “.IEV”. 

18. 5th August – Now it is also possible to rotate a TEXT object to any angle from 0 to 
359 degrees.  To do this:  

a. Select an object,  

b. Choose “Object(s) � Selected � Adjust Properties…” menu,  

c. Press the “Text Effects…” button on the “Change Object Properties” dialog, 

d. Choose “None (Rotate)” from the Text Effects options, 

e. Use the “Text Angle” slider to rotate the text. 

19. 6th August – Added “Object(s) � Selected � Text Effects…” menu.  This menu 
opens a dialog that has options to rotate, or create shapes with, the text. 
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20. 6th August – Added “Object(s) � Deselect All” menu. 

21. 7th August – Added “File � Copy to Folder…” menu that lets you browse for a 
destination folder to which to copy the current image file. 

22. 7th August – Added “File �Move to Folder…” menu that lets you browse for a 
destination folder to which to move the current image file. 

23. 7th August – Added “File � Send to Recycle Bin…” menu that lets you ‘bin’ the 
current image file. 

24. 7th August – Added “File � Delete Permanently…” menu to permanently delete 
the current image file. 

25. 7th August – Added 2 toolbar buttons: ‘Send to Recycle Bin’ and ‘Permanently 
Delete’ to remove the current image file. 

Image Contact Sheet Manager 

1. Now the Images are Auto-Rotated if they contain EXIF orientation tags. 

2. Added the ability to read previously unsupported RAW formats. 

Create AVI from Images 

1. Now the Images are Auto-Rotated if they contain EXIF orientation tags. 

2. Added the ability to read previously unsupported RAW formats. 

Slide Show 

1. Added the ability to read previously unsupported RAW formats.  

Thumbnail Viewer 

1. Added “Thumbs � Update Changes Only” menu option.  This option differs to the 
“Refresh” option, in that it only updates the displayed image for thumbs currently in 
the Thumb Viewer, and removes Thumbs if the file no longer exists.  It does NOT 
add any new Thumbs, as “Refresh” would do. 

2. Now orientates the EXIF preview image to the main image. 
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Version 1.4.9 – 25th June 2006 

File Manager 

1. Now you can Open Xplorplus by Right-Clicking the Mouse on any Windows File-
System object (File, Folder, Drive, or Shortcut), then selecting the “Open in 
Xplorplus” or “Browse in Xplorplus” menu option from the Windows Context Menu. 
If the object is NOT part of the File-System, i.e.: “My Computer” or “Recycle Bin”, 
Xplorplus will open in the C: drive root directory (C:\).  

2. Now, if Xplorplus is opened by a Right-Click on a File-System object (explained 
above), and the object is a file or shortcut, it will be visible and highlighted in the 
File List. 

Image Viewer 

1. Now the “Choose a Rectangular Selection Size…” dialog shows selection 
dimensions and position in Pixels, Inches and Centimetres. 

2. Now the resolution, or DPI, of the displayed “Print Preview Selection” image is 
matched to that of the actual image.  

3. Added logging of DPI change. 

4. Now the “Choose a Rectangular Selection Size…” dialog also shows the “Aspect 
Ratio” of the selected area. 

5. Added “Aspect Ratio” to the Properties displayed from the “Options � Show 
Properties” menu. 

6. Added “Tools � Generate Color Chart” menu option.  Clicking this option 
generates a 28-line, 364-color chart in a TIF.  The TIF can be modified and saved 
like any other image. 

7. Changed  “Image � Convert Image or Selection to � Desaturated” to read “Image 
� Convert Image or Selection to � Desaturated (Absolute)”. 

8. Added “Image � Convert Image or Selection to � Desaturated (Average)” menu 
option.  This option uses a different algorithm to the “Desaturated (Absolute)” 
option, and thus creates a different gray result. 

9. Now the “Selection Effects” controls (checkbox, sliders and etc), move to the right-
hand side of the standard zoom controls and displayed information, when the 
window is wide enough to display all the controls.  It moves below when the window 
is too narrow. 

10. Fixed a bug in the “Image � Correct Non-Level Horizon” dialog that caused it to 
display an error message at certain times.  

11. Now the “Image � Correct Non-Level Horizon” dialog has no “Undo” button.  The 
Undo process is now performed when pressing the “Back” button after doing the 3rd 
step. 

12. Now the “Drag Drop Zone” is made visible, when the “Options � Show Drag-Drop 
Zone” is selected, by widening the window if it would have been too far to the right. 

13. Now, when pasting to a Circular or Elliptic Selection, with Feathering checked, the 
image is pasted and feathered correctly. 
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14. Fixed a bug that caused the Log file to be produced, even after Cancelling the Save 
process midway, or answering “No” when “Prompt to Save if Changed” is checked 
and the image has changed. 

15. Added “Selection � Build Selection Point-by-Point” menu option.  When chosen, 
this option allows the user to build a selection marquee by repeatedly clicking on 
the image to create a closed polygon.  Unlike other selection techniques, this one 
allows the last selection point to be removed and optionally placed in a different 
position. All previous points can be removed and then re-clicked.  The displayed 
dialog contains buttons to “Remove the Last Point”, “Finish”, and “Cancel” the 
marquee. 

16. Now there is NO Red Line displayed in the “Correct Non-Level Horizon” dialog.  
Feedback indicated that the red line complicated the procedure too much.  Now the 
2nd Yellow Line can be forced to the Horizontal or Vertical by dragging the end of 
the line while holding down the CTRL key. 

17. Now the EXIF Preview image is correctly orientated with the main image, in images 
that are saved, when the "Options � Update EXIF Image on Save" is checked. 

18. Now the main image is saved with the correct orientation regardless of whether 
“Auto-Rotate” is on or off.  The image is saved AS DISPLAYED regardless of the 
setting. 

19. Now, when “Options � Auto-Rotate JPEGs and TIFFs” is UNCHECKED, a warning 
message is displayed explaining that the image orientation may be affected. 

20. Now the EXIF Preview Image and Properties are available in images saved with 
the “File � Save a Copy (for Emailing?)…” menu option. 

Thumbnail Viewer 

1. Added “Slide Show � Show File Name” menu option. 

2. Now, when Thumbs are rotated with “Auto-Save” checked, the EXIF and Main 
image are correctly oriented. 

Slide Show 

1. Now the Slide Show automatically rotates JPEGs and TIFFs if they contain 
orientation information. 

2. Now Right-Clicking the Mouse on the Slide Show Control will hide it.  Click the 
Right-Mouse again to show the context menu, then select “Show Control” to display 
it again. 

3. Now holding the “Ctrl” key down while Right-Clicking the Mouse on the image will 
toggle between Hiding and Showing the Slide Show Control. 

4. Now, if the Slide Show Control is hidden, moving the mouse briskly will display the 
Control again. 

5. Now the Mouse Cursor is hidden and redisplayed with the Slide Show Controls. 

Image Batch Conversion 

1. Now, the EXIF and Main image are correctly oriented in the converted image file. 
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Version 1.4.8 – 3rd June 2006 

File Manager 

1. Now the Information documents displayed from the “Help � Information 
Documents” menu are in PDF format and can be read using Adobe Reader version 
3.0 or later. 

Image Viewer 

1. Now the menu options on the “Image” menu, that only work on the entire image, 
are greyed-out when a part of the image is selected. 

2. Now there is an automatically created RAW Image Profile for each and every 
unique Extension and Camera Type.  This allows the viewer to configure the 
settings of the profile individually for the images from each camera source.  A 
dialog is displayed every time the applied profile is changed as a result of Image 
Viewer detecting an image from a different camera. 

3. Now the “Save As…” dialog is displayed if “Prompt to Save if Changed” is checked 
and the image is changed, when attempting to close Image Viewer or view another 
image.  Pressing “Cancel” discards the changes and continues. 

4. Now it is NOT possible to “Save As” an image with an unsupported extension.  If 
you try to, a message is displayed telling you to try again, then you are returned to 
the “Save As” dialog. 

5. Added “File � Edit EXIF User Fields…” menu option.  Only available if the EXIF 
fields are detected in the image. 

6. Added “Edit EXIF User Fields” dialog.  This dialog lets the user to add, modify, or 
remove the User Comment and User Copyright fields stored in the EXIF header of 
the image. 

7. Fixed a bug that occurred after an image file is deleted, then the “Options � Show 
Properties” menu option is selected. 

8. Now offers RAW support for 206 (was 121) models of 28 (was 13) makes of 
camera. 

9. Fixed a bug in the “Tools � Select Source…” dialog that caused the selected 
TWAIN source to be ignored, and reverted back to the default system selection. 

10. Added “Options � Update EXIF Image on Save” menu option.  When this option is 
checked, the EXIF Thumbnail is changed to represent the main image and saved. 

11. Fixed a bug that caused Xplorplus to crash when the “Magic Wand” dialog was 
open when applying a change from the “Sharpen or Soften” dialog. 

12. Now the Selection Marquee is positioned correctly after a selected area has been 
cropped. 

13. Now the Selection Marquee is not removed when “Edit � Undo” is used and a part 
of the image is selected. 

14. Optimized the “Image � Auto Sharpen algorithm. 
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15. Added “Image � Auto Resample” menu option.  This option applies an algorithm 
that correlates adjacent pixel values to create a smooth pixel-to-pixel brightness 
transition. 

16. Now it is possible to extend a Magic Wand selection, while the dialog is open, by 
holding down the Shift Key and the Left Mouse button together, then dragging the 
mouse cursor from the selected area into a new unselected area of the image.  The 
pixel that you are pointing to with the mouse at the moment you release the Left 
Mouse button becomes the new color (within tolerance) to determine the new 
additional selection. The instructions are written on the Magic Wand Selection 
dialog, in blue. 

17. Now “Print Preview Selected” dialog remembers the settings from the previous use. 

Image Batch Conversion 

1. Now the Input and Output file names are logged, if logging is enabled. 

2. Fixed a bug that caused the Log file to disappear sometimes. 

3. Now the RAW Color Profile applied, is automatically determined for each image 
converted, if “RAW Color Profiles” is enabled in Image Viewer. 

4. Now, for RAW image types, the RAW Color Profile name is logged, if Logging and 
Profiles are both enabled. 

Image Adjustment Dialogs 

1. Now it is NOT possible to view another image while an adjustment dialog is open.   

2. The Xplorplus File Manager is now NOT active while an adjustment dialog is open. 

3. Now, clicking on an image in the Thumb Viewer while an adjustment dialog is open 
will NOT show the clicked image in Image Viewer. 

4. Now, pressing the “Recall Last Applied Settings” button also recalls the value of the 
RGB Channel check boxes, if they exist on the dialog. 

5. Now, pressing the “Reset All Settings to Defaults” also resets the value of the RGB 
Channel check boxes, if they exist on the dialog. 

6. Fixed a bug that caused Xplorplus to crash when applying changes in the “Rotate” 
and “Size” dialogs. 

7. Now the “Size” dialog allows a maximum increase of double the pixel width and 
height, instead of 1.5 times (ie: 3000 x 2000 � 6000 x 4000 pixels). 

Thumbnail Viewer 

1. Added “Options � Thumb Display Style” menu. 

2. Added  “Options � Thumb Display Style � Custom Colors” menu option.  This is 
the original view. 

3. Added  “Options � Thumb Display Style � Drop-Shadow” menu option.  This 
option displays the Thumbs with a 3-D drop shadow look.  Background and Border 
colors cannot be changed when this option is selected. 

4. Added “Options � Auto Adjust Orientation” menu option, that if checked rotates the 
image according to the EXIF orientation data, if found. 
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Version 1.4.7 – 15th May 2006 

File Manager 

1. Added “Wipe and Destroy Files…” option to the context sensitive popup menu that 
appears on the Right-Click of the Mouse in the File Lists.  For all selected files plus 
files in selected folders, this option clears the file contents before permanently 
removing all traces of the original file.  A confirmation dialog appears before 
proceeding.  This feature can be used to ensure absolute privacy of deleted file 
information. 

2. Fixed a bug that caused “New Folders” to be created in the wrong Parent folder 
when right-clicking the mouse on a “non-current” folder in the Drive/Folder list. 

Image Viewer 

1. Changed the dialog box that appears if the “File � Prompt to Save if Changed” 
menu option is checked, and the image has been changed.  This dialog appears 
only if the image has changed and Image Viewer is closed, or the Next Image is 
requested.  Now, hopefully, it is more user-friendly. 

2. Changed the title of the “Selection Feathering” checkbox to “Selection Effects” 
because it enables both Feathering and Transparency. 

3. Improved the operation of the “Selection Effects”, both Edge Feathering and 
Transparency, when using the “Edit � Copy Selection” option, followed by the “Edit 
� Paste to Selection” option. 

4. Now ‘Saving’, ‘Backing-Up’ an Image, and ‘Merging Objects’ operations, are all 
logged if logging is active. 

5. Added RAW support for Imacon and Sinar data-backs, and 4 other new models of 
cameras. 

6. Added the ability to Open and Save images with the Adobe Photoshop .PSD 
format.  Although, currently, any layers will be merged if changed and saved. 

7. Improved the “Saturation” algorithm used on the “Hue, Saturation and Lightness” 
dialog. 

8. Added a “Tint” option, as an alternative to “Hue”, on the  “Hue, Saturation and 
Lightness” dialog. 

9. Added “Image � Convert Image or Selection to � Colorized Grayscale…” menu 
option. 

10.  Added “Colorized Grayscale” dialog.  This feature can be used to change any 
image to a “coloured” greyscale image. 

11.  Added various EXIF properties: Exposure Mode, Equiv. 35mm Focal Length, 
White Balance, Scene Setting, Gain Control, Camera Contrast, Camera 
Sharpening, Camera Saturation, and Subject Distance. 

12. Added “Settings � RAW Image Color Profile” menu option. 

13. Added “Settings � RAW Image Color Profile � Enable” menu option. 

14. Added “Settings � RAW Image Color Profile � Settings…” menu option. 
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15. Added “RAW Image Color Profile Settings” dialog that can be used to configure the 
color multipliers applied to a RAW image type, while it is being loaded into the 
viewer.  The changes are applied to all RAW images subsequently loaded, if the 
Profile is Enabled using the appropriate menu option. 

16. Added “Inner Shading” effect to the “Edge Fade, Border, and Shadow Settings” 
dialog, opened from the “Image” menu. 

17. Added GPS (Global Positioning System) EXIF information to the Properties display, 
if present.  Values include: 

• GPS Version,   

• UTC (Universal Coordinated Time, same as GMT) Date Stamp,   

• UTC Time Stamp,   

• Latitude,  

• Longitude,  

• Reference Altitude,    

• Relative Altitude,  

• Image Direction, and  

• Geodetic Survey Data. 

Image Batch Conversion 

1. Included the “RAW Image Color Profile” setting in the Batch Conversion, if enabled 
in Image Viewer. 



 XplorPlus Changes 

Author and Copyright: Raysoft Systems Page 36 of 64 Date: 24 June 2010 

Version 1.4.6 – 24th April 2006 

File Manager 

1. Improved the way that the ‘plus-signs’ are removed from remote shared folders 
(UNC’s) that have no sub-folders, in the drive list. 

2. Added “Options � Activate List Under Mouse” menu option.  When this option is 
checked, it is NOT necessary to click the mouse on a Drive or File list to make it 
active. 

3. Made a slight re-arrangement of the “Options” menu items. 

Image Viewer 

1. Added “Options � Log Image Changes” menu option.  When checked, Image 
Viewer creates a LOG file, when the changed image is SAVED or CLOSED. The 
LOG contains Time-Stamped details of the changes made to the whole image, line-
by-line.  Subsequent OPENS and CHANGES are appended to the log file.  The 
LOG file is in the same folder as the image with the same name + “.log” on the end.  
The features that are logged are: 

a. All the “Image” menu options, including when a part of the image is selected. 

b. All the Speed-Key functions. 

c. All the “Selection” menu options that change part of the image. 

d. All the “File” menu options that change all or part of the image. 

e. The “Edit” Cut, Paste, Cut Selection and Paste to Selection options. 

2. Added “Options � Show Log File…” menu option.  This view of the Log file is 
updated whenever the image is changed, and indicates whether logging is enabled 
or not. 

3. Added a Checkbox and Slide Adjuster to allow Feathering the edges of selections.  
Feathering blends the edges of a selection to the non-selected part of the image.  
Feathering can use a pixel radius of between 0.1 and 100.0 pixels.  This Checkbox 
is only available when the Mouse is set to select part of the image. 
The features that are Feathered are: 

a. All the “Image” menu options where a part of the image is selected and 
changed, including those done using the Image Adjustment dialogs. 

b. All the “Selection” menu options that change part of the image. 

c. All the “File” menu options that change part of the image. 

d. The “Edit” Paste to Selection option. 

4. Added the ability to adjust the Alpha Transparency of a change applied to a 
Selected part of the Image.  This feature (slide adjuster) is only available when the 
Mouse is set to Select a part of the image. 

5. Added “Selection � Shade Outside Selection” menu option.  This option greys out 
the area, which is not selected, to emphasise the selected area. 
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6. Added “Selection � Save Marquee Position” and  “ � Restore Marquee Position” 
to save and restore the selection shape.  The saves queue as: Save (1), Save (2), 
Save (3), etc, and the Restores are as follows: Rest (3), Rest (2) and Rest (1). 

Image Adjustment Dialogs 

1. Now it is NOT possible to De-Select a Selected image when these dialogs are 
open. 

Image Batch Conversion 

1. Added a check-box option called “Log Changes” to the “Image Adjustments” dialog.  
All requested adjustments are recorded into an individual log file for each image 
processed in the batch.  The LOG file is in the same folder as the converted image 
and with the same name as the image file + “.log” on the end. 

FlushIE 

1. Now ‘Wipes’ the Cookie and Index files, by writing binary zeroes (0’s) through their 
entire lengths, before deleting them.  This makes it impossible to retrieve any data 
from them if they are recovered by a third-party application. 

2. Minor title and display changes. 

Image Contact Sheet Manager 

1. Changed the toolbar and Icon, used to open a Contact Sheet in the Image Viewer 
for viewing and printing etc, to a normal Text button. 
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Version 1.4.5 – 13th March 2006 

Image Viewer 

1. Added a Toolbar containing buttons for most of the commonly used options, eg: 
Open, Close, Print Preview, Previous/Next Image, Undo, Redo, Zoom, Properties, 
Speed-keys, and 8 Image Adjustments. 

2. Added “Options � Log Image Changes” menu option.  When checked, Image 
Viewer creates a LOG file, when the changed image is SAVED or CLOSED. The 
LOG contains Time-Stamped details of the changes made to the whole image, line-
by-line.  Subsequent OPENS and CHANGES are appended to the log file.  The 
LOG file is in the same folder as the image with the same name + “.log” on the end. 

Associations Manager 

1. Now double-clicking the left mouse button on an association item opens the 
“Change Association” dialog. 

Change Properties 

1. A small misbehaviour in the “Invert Selection” option has been fixed. 

Control Panel Viewer 

1. Now “Show Tooltips” works properly. 

Network Viewer 

1. Now “Show Tooltips” works properly. 

Printers Viewer 

1. Now “Show Tooltips” works properly. 

Image Batch Conversion 

1. The “RGB Color Intensity” setting titles have been changed from “Gradient Start” 
and “Gradient End” to “RGB Start Value” and “RGB End Value”, respectively. 

Image Adjustment Dialogs 

1. The “RGB Color Intensity” dialog setting titles have been changed from “Gradient 
Start” and “Gradient End” to “RGB Start Value” and “RGB End Value”, respectively. 

Speed-Keys Dialog 

1. The “RGB Color Intensity” dialog setting titles have been changed from “Gradient 
Start” and “Gradient End” to “RGB Start Value” and “RGB End Value”, respectively. 
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Version 1.4.4 – 28th February 2006 

Image Batch Conversion 

1. Added an "Image Adjustments" button. 

2. Added an "Adjust Images" Checkbox to enable the “Image Adjustments” button. 

3. Added a "Batch Image Adjustments" dialog displayed when "1" above is pressed.  
This dialog configures batch change settings for:  

a. Contrast and Brightness,  

b. Hue, Saturation, and Lightness,  

c. RGB Color Levels,  

d. RGB Color Intensity,  

e. RGB Color White Balance,  

f. Sharpen,  

g. Threshold and Equalization,  

h. Remove Color Cast, and  

i. Convert to Grayscale. 

j. Rotate or Flip (5 options) 

4. Now, if the Output Format is JPEG, it is possible to choose the Quality and 
therefore the Size of the output image.  There are 19 settings plus ‘auto’, which 
calculates the quality of the input image for the output quality. 

5. Now it is possible to highlight multiple files in the file list (by holding down the Ctrl or 
Shift keys), and then press the new “Select Highlighted” button, to check them. 

6. Now uses the new improved Contrast algorithm. 

Image Adjustment Dialogs 

1. Added "Add to Batch Conversion Settings" button to all the relevant dialogs. 

2. Improved the Contrast algorithm on the “Contrast and Brightness” dialog, plus it 
can now work in the 3 RGB channels independently, and the Contrast Midpoint 
(lighten/darken) can be adjusted. 

3. Changed “Image � Adjust Image or Selection � RGB Color Intensity…” dialog to 
work with a completely new algorithm. Basically it allows you to increase or 
decrease the color Intensity between a Start and End RGB color range.  The value 
is applied “progressively” to the range to produce a gradual brightening or 
darkening into the middle of the range.  The effect is a very smooth and effective 
improvement in the perceived color dynamics. 

4. Changed the “Image � Convert Image or Selection to � RGB Swap/Greyscale…” 
dialog to combine the ability to swap RGB channels and create Grayscales based 
on Red, Green, Blue, or Normal. 

5. Removed the “Perceived Contrast” adjustment dialog. 
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Image Viewer 

1. Added "Options � Show Speed-Keys" menu option, to apply preset image 
adjustments quickly. 

2. Now ALL the menus are disabled while the “Image � Rotate or Flip � Correct 
Non-Level Horizon…” dialog is open.  You must close the dialog to use the menus 
again. 

3. Added “Selection � Invert” menu option. 

4. Fixed a bug that caused the progress bar to stay visible sometimes, after 
completing a process. 

7. Now offers RAW support for 121 (was 115) models of 13 makes of camera 
including the new Nikon D200, Canon EOS 20Da and Pentax *ist DS2. 

8. Added “File � Save a Copy (for Emailing?)…” menu option and dialog, to create 
various JPEG sizes and qualities as a COPY of the image, in the current folder. 

9. The Print Preview dialog now opens quicker. 

Image Speed-Keys (New) 

1. Added a new dialog that offers 10 Instant and Configurable Key shortcuts to 10 
image adjustments, which can be changed as they are being used. 

2. Now has the ability to update 1 or All the Image Adjustment settings for Batch 
Conversion, with the current Speed-Key values. 

3. Now uses the new improved Contrast/Midpoint algorithm. 

File Manager 

1. Now, when the Evaluation Period has expired and the product has not been 
registered, Xplorplus shows the “Purchase Xplorplus XP” dialog, to help the user 
connect to the appropriate web page, fill in their details and download a 
Registration Number. 

2. Added “Tools � Batch Convert Images…” menu option to open the Batch 
Conversion dialog. 

3. Fixed a tiny bug that caused Xplorplus to terminate when a particular menu option 
was chosen, in a certain context. 

Screen Capture 

1. Now Screen Capture remembers ALL the menu option settings. 

Thumb Viewer 

1. Added “Tools � Batch Convert Images…” menu option to open the Batch 
Conversion dialog. 
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Version 1.4.3 – 23rd January 2006 

File Manager 

1. Added a new main menu called "Managers" 

2. Moved "Create Image Contact Sheets..." from the "Tools" menu to the "Managers" 
menu. 

3. Added "Create AVI File from Images..." to the "Managers" menu. 

4. Moved "Rename Multiple Files..." from the "File" menu to the "Managers" menu. 

5. Moved "Clear Internet Explorer Cache..." from the "Tools" menu to the "Managers" 
menu. 

6. Added "Clear Work Files..." to the "Managers" menu.  This option lets you clear the 
"Recent Documents", "Temporary", and IE Caches and/or configure them to be 
cleared at startup time. 

7. Moved "Change Properties for Files..." from the "Tools" menu to the "Managers" 
menu. 

8. Moved "Change File Associations..." from the "Tools" menu to the "Managers" 
menu. 

9. Updated the Help file. 

10. Updated the Keyboard Shortcut Help file. 

11. Implemented a "Smart-Positioning" strategy when opening all X+ windows and 
dialogs.  This works to ensure that any windows are totally within the screen when 
first opened, even if the resolution of the screen is reduced.  

12. Added "Help � Information Documents" menu option, with submenus, to view the 
"X+ Whats New.rtf", "X+ Supported Image Formats.doc", "X+ Features.doc", and 
"X+ Supported Digital Cameras.doc" documents. 

Image Viewer 

1. Now Copy/Cut/Paste recognise alpha transparency within the application. 

2. Now there is an additional Threshold control which affects all RGB channels 
simultaneously, using a different calculation. 

3. Now the Print Preview dialog settings for Margins, Position, Gamma and Size are 
remembered between Xplorplus sessions. 

4. Enhanced image quality for Digital Camera RAW images. 

5. Now 13 Digital Camera makes, and 115 models are supported.  See the "X+ 
Supported Digital Cameras.doc" Word document in the zip file. 

6. Now all the following Image Adjustment dialogs can RECALL the Last Used 
settings: Contrast/Brightness, Perceived Contrast, Hue/Saturation/Lightness, RGB 
Color Levels/Intensity/White Balance, Sharpen/Soften, Threshold/Equalize, Size, 
and Rotate - Arbitrary. 

7. Now there is a NEW IMPROVED THRESHOLD algorithm that works separately in 
all the RGB channels. 
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8. Now the "File � Print..." option uses the same image position settings as those last 
set and used in the Print Preview dialog. 

2. Added "Options � Auto-Rotate JPEGs and TIFFs", that rotates these image types 
if the orientation value is found in the EXIF information.  Therefore, it only affects 
Digital Camera images. 

3. Added "Image � Compare with Original..." menu option.  Shows the Original and 
Changed images side-by-side for comparison.  Zooming and Scrolling of the 2 
images can optionally be Synchronised.  Any change to the main image updates 
the right-hand "Changed" image.  If the image is changed to another file, both 
"Original" and "Changed" are updated within a second. 

4. Added Pixel Coordinate, Color and RGB value displays to both the "Original" and 
"Changed" images headers. 

5. Added "Options � Synchronise Pixel Info" to "Compare with Original" dialog.  This 
option automatically shows the info for the exact same pixel coordinate at the 
mouse point, for both images simultaneously.  Only available if both the images are 
exactly the same size. 

6. Changed all the Image Adjustment "Save" buttons to show as "Apply", plus added a 
descriptive ToolTip to explain the button's function. 

Search Drives 

1. Now Folders are also found if they match the search criteria. 

FlushIE 

2. Now also clears the "Recent Documents" and "Temporary Files" folders on Startup, 
if requested. 

7. Now the Startup Display does NOT show the ACTUAL folder names of the objects 
cleared. 

Image Contact Sheet Manager 

1. Added "Hide Borders" option.  This option can be used to remove the gray lines 
around each image. 

8. Added "Show Folder Name" to the "Headings" options.  Unchecking this option 
removes the second heading line that shows the folder the contact sheet images 
came from. 
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Version 1.4.2 – 28th December 2005 

Image Viewer 

1. Added "Image � Adjust Image or Selection � RGB Color Intensity..." dialog. 

2. Removed menu "Image � Change Resolution and/or Size..." menu and dialog. 

3. Added menu "Image � Change Size, Proportion, DPI..." menu and dialog.  This a 
complete replacement for, and with a different approach to, the dialog deleted in 
point 2 above. 

4. Added "Tools � Make AVI from Images..." menu.  To compile multiple images of 
any compatible formats, and any mixture of sizes, into a single AVI file. 

Thumb Viewer 

1. Added "Tools" main menu. 

9. Added "Tools � Make Contact Sheets..." menu, moved from the "Thumbnails" 
menu. 

10. Added "Tools � Make AVI from Images..." menu.  To compile multiple images of 
any compatible formats, and any mixture of sizes, into a single AVI file. 

11. Moved the "Thumbnails � Refresh Thumbs" menu to the top of the menu list, for 
easier access. 

Create AVI from Images 

1. New dialog to compile any number of images in a folder, of any compatible formats, 
and any mixture of sizes, into a single AVI file. 

 



 XplorPlus Changes 

Author and Copyright: Raysoft Systems Page 44 of 64 Date: 24 June 2010 

Version 1.4.1 – 23rd December 2005 

Image Viewer 

1. Added "Image � Auto Sharpen" menu option. 

2. Added "Image � Auto White Balance" menu option. This feature works best for 
images without white colors. 

3. Added "Image � Remove Color Cast" menu option.  This feature works best with 
poor quality images to improve the color balance. 

4. Added a "Shadow Contrast" adjustment control to the "Image � Adjust Image or 
Selection � Contrast and Brightness..." dialog. 

5. Added "Image � Adjust Image or Selection � RGB White Balance..." dialog. 

6. Added "Image � Adjust Image or Selection � Perceived Contrast..." dialog. 

7. Added "Mouse Action � Adjust White Balance" menu option.  Use this feature to 
click on colors in the image to adjust the WB results, until satisfied. 

8. Added a Color Indicator box, between the X-Y Coordinate and RGB Color displays, 
that displays the actual color under the mouse pointer. 

9. Fixed a cursor bug. 

10. Added a Panel in the Status Bar at the bottom of the Image Viewer, to indicate the 
current use of the Mouse. 

11. Changed "File � Open..." menu to show as "File � Open in Current Folder..." 

12. Added "File � Open in Last 'Save As' Folder..." menu, to avoid the need to 
navigate back and forth between folders when opening images. 

13. Added "File � Save As in Current Folder..." menu, to avoid the need to navigate 
back and forth between folders when saving. 

Rename Multiple Files 

1. Simplified the dialog, to show only the 'New File Name Template' components on 
the window that are actually in use, hiding all the others. 

IE Cache Manager 

1. Changed the color of the title in the Startup dialog. 
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Version 1.3.4 – 9th December 2005 

File Manager 

1. Moved the "Tools � Viewers" menu from the "Tools" menu to an main menu of it's 
own. 

Image Viewer 

1. Added "Mouse Action � Magnifier" menu to display a moveable image magnifier.  

2. Added "Settings � Magnifier Style � Rectangular" menu. 

3. Added "Settings � Magnifier Style � Circular" menu. 

4. Added "Settings � Magnifier Style � Magnify 200%" menu. 

5. Added "Settings � Magnifier Style � Magnify 300%" menu. 

6. Added "Settings � Magnifier Style � Sizeable" menu. 

7. Fixed a bug that sometimes made it difficult to size a selected area on certain drag-
handles. 

8. Changed the "Create an Object � Highlight Rectangle" to display as "Color Filter" 
to be more accurate about it's intended use. 

9. Fixed a bug that causes Xplorplus to fail when an image with the PCL format is 
read.  Now a message displays instead. 

10. Now the EXIF Preview Image is properly displayed, when requested, for the PEF 
(Pentax) Camera RAW image type. 

11. Added "Options � Fast-Read Camera RAW Images" menu option to speed up the 
display speed.  NOT recommended for editing, only viewing the image as only half 
the image is read. 

12. Now the Print Preview Measure Units are changed to Inches/Centimetres when the 
"Settings � Measure Units" menu options are changed. 

13. Added a Caption to the Print Preview Dialog and Window. 

14. Fixed a bug that caused the Rotation Sampling Method setting to change 
sometimes. 

15. Added "Image � Rotate or Flip � Correct Non-Level Horizon..." menu option and 
3-step dialog, to rotate an image by drawing 2 lines along the existing horizon and 
the required horizon, then using the angle between them to calculate the degrees 
of rotation. 

16. Reduced the size of the "Image � Adjust Image or Selection" dialogs, and changed 
the font style. 

17. Changed all the dialogs to use the same font. 

18. Now the displayed image size units change through 'Pixels > Inches > Centimetres' 
as the "Settings � Measure Units" selection changes. 

19. Added "Settings � Always Display Pixel Size" menu option to override the previous 
point (18) setting. 
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20. Added "Image � Change Aspect Ratio..." menu option and dialog, to change either 
width or height and thereby changing the rectangular proportion. 

21. Added "Image � Balance Color Channels" to repair poor quality images by 
removing excessive color bias. 

22. Changed the look of the Properties display to to a Ledger-styled list, to make it 
easier to see each individual line. 

23. Fixed a bug that could cause the wrong file type to display after a "File � Save 
As..." operation. 

24. Added "Settings � Acquired Image Format � JPEG" and "(same) � TIFF" to allow 
the choice of a JPG or TIF output from the scan. 

Slide Show 

1. Now the Floating Control is semi-transparent to make it less obtrusive. 

2. Now the Floating Control is re-positioned to still be visible if the screen size is 
reduced and it would have been off the screen.  This is important for users with a 
laptop who sometimes plug into a monitor with a different size. 

3. Added a Drop-Down menu containing all the options shown on the Floating Control, 
plus an option to Show or Hide the control, for people who like menus. 

4. Fixed a bug that caused an error when double-clicking the right mouse button on 
the floating control. 

Thumb Viewer 

1. Changed the way the "Slide Show � Sound" menus work. 

2. Fixed a bug that happens in Windows XP with SP3 where the mouse is moved over 
a non-file thumb causes an error 53 "File not Found". 

3. Fixed a bug that ONLY occurs under XP SP3 (NOT officially released by Microsoft 
as at 16-11-2005), that causes the Thumb Viewer to read Folders as Files!!! 

4. Improved the caching of thumb images to cater for lots of large images. 

5. Added a Caption to the Print Preview Window. 

6. Fixed a bug that caused Pentax PEF format images to show as black. 

7. Changed the "Thumbnails � Open in Internal Viewer" menu caption to 
"Thumbnails � Open in Image Viewer". 

Image Contact Sheet Manager 

2. Added a Caption to the Print Preview Window. 
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Version 1.3.3 – 26th October 2005 

Recycle Bin Viewer 

1. Fixed a bug that caused the drop-down menu to take 2 right-mouse clicks to open 
the first time it was used. 

2. Improved the auto-update algorithm. 

Printers Viewer 

1. Fixed a bug that caused a Catastrophic Failure on some systems when the drop-
down menu was opened. 

Network Viewer 

1. Improved the user interface to show shares, folders and files properly in the file list. 

2. Simplified the context menus. 

3. Now drag-and-drop of folders and files is supported when appropriate. 

Image Viewer 

1. Removed Screen Size menu option. 

2. Improved the algorithm for calculating the Displayed Print Size of an image. 

3. Now the "Show EXIF Preview Image" menu option setting is saved on exit. 

4. Now when the mouse is moved over the EXIF preview image (when visible), the 
Offset and RGB color values are displayed in the relevant boxes with a Yellow 
background. 

5. Added "Image � Convert to � Desaturated" menu option.  This option is similar to 
"Convert to � Grayscale", but uses a different algorithm and produces a slightly 
different result. 

6. Added "Image � Remove RGB Channels � Red" etc. menu options. Red, Green 
and Blue color channels can be removed completely, either individually or in any 
combination. 

7. Added "Image � Add Border � White" menu option. 

8. Added "Preview" checkbox option to all the adjustment dialogs, to see the 
difference between the original and the adjusted image. 

9. Fixed bug that caused the mouse cursor to remain as a "move" image when an 
area is selected. 

10. Added "Image � Fade Edge � to Background Color" menu option. 

11. Now the "Preview" feature of the Image Adjustment dialogs also works when 
adjusting a selected area of the image. 

12. Added "Reverse Cut" option to the Threshold and Equalization adjustment dialog, 
to cut dark colors to white and light colors to black, which is the reverse of normal. 

13. Removed 2 of the "Mouse Action � Magic Wand" menu options leaving 1 general 
option that when selected, displays the Magic Wand Settings dialog. 
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14. Replaced all the Magic Wand Settings menu options with an interactive dialog.  The 
dialog allows the Clicked Color Behaviour and Color Tolerance to be changed while 
clicking on the image to fine tune the result. 

15. Added the ability to De-Select a selection by Right-Mouse Clicking anywhere on the 
image. 

16. Removed and replaced All the "Image � Fade Edge/Add Border/Add Shadow" 
menus with an interactive dialog, where the settings can be adjusted while trying 
out the results.  Includes an Undo option. 

17. Fixed a bug that caused a Save dialog to repeatedly appear when "File � Prompt 
to Save When Changed" menu option selected. 

18. Fixed a bug that sometimes appears when Editing a Polygon object. 

19. Simplified the wording and layout of the "Image" menu options. 

20. Now the "Mouse Action � Object Selection" menu option is not available when 
there are no objects on the image. 

21. Now, before exiting or moving to the next image, if there are unmerged objects on 
the image, and even if "Prompt to Save if Changed" is NOT checked, a dialog will 
appear to ask you if you want to Merge the objects. 

22. Now the "Offset - RGB" window shows the R, G, and B as Red, Green, and Blue 
numbers, respectively. 

23. Now the "Offset - RGB" window values are updated while the Image Adjustment 
dialogs are showing. 

24. Now it is possible to Move and/or Resize selected objects using the arrow keys with 
a combination of Ctrl and Shift keys. Just the Arrow keys will Move the selected 
objects 1 pixel. The Shift+Arrow keys means Resize by 1 pixel. By holding the Ctrl 
key down as well, Moving and/or Resizing increases to 5 pixel changes. 

25. Now Ctrl-C, Ctrl-X, and Ctrl-V Copy, Cut and Paste Objects when 1 or more objects 
are selected. When NO OBJECT is selected these keys normally Copy, Cut or 
Paste the Image. 

26. Re-designed the Object Properties dialog, to simplify it and add Object "Position & 
Size" information.  Replaced all the option buttons with drop-down lists to save 
space, and added the Pen, Fill and Font information for the selected object. 

27. Now, when you click the mouse on an object, move it, or size it, a tooltip appears 
for 15 seconds to show the position and size of the object. 

28. Improved the layout and displayed decimals in the Print Preview dialog. 

29. Fixed a bug that caused the wrong objects to be deleted if they were created by a 
Copy and Paste action. 

Image Contact Sheet Manager 

1. Added 6 common "Screen" sizes to the choices in the Sheet Size drop-down list 
box.  

Rename Multiple Files 

1. Simplified the perceived dialog by placing PREFIX and SUFFIX rename options on 
2 separate tabs. 
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2. Now the text boxes are greyed-out if they do NOT contain text. 

Slide Show 

1. Added a floating Control containing buttons for Pause/Continue, Exit, Previous, 
Next, Faster, Slower, Remove and Help. 

2. Added a Mute button to the floating control. 

3. Now the mouse pointer changes to a 'move-hand' when over the left-most 'move-
control' button. 

Thumb Viewer 

1. Added a Sound option to the Slide Show. 

2. Added "Slide Show � Sound � Play Sound File(s)" menu option.  If no files have 
been selected, a dialog will appear automatically to let you choose the sound files.  
Pressing Cancel will keep the previous selections if any, or turn off sound if there 
was not a previous selection. 

3. Added "Slide Show � Sound � Pause Sound with Image" menu option.  When 
this option is checked, the sound is paused when the slide show is paused. 

4. Added "Slide Show � Sound � Choose Sound File(s)" menu option.  This option 
lets you select 1 or more sound files.  If 1 file is selected it will be played 
repeatedly.  If multiple sound files are selected (using the Ctrl or Shift keys) they 
will all be played in succession then repeated.  If no sound file is selected and there 
was not a previous selection, no sound will play. 
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Version 1.3.2 – 28th December 2005 

Image Viewer 

1. Changed the Image Adjustment dialogs so preview changes are made to the main 
image instead of the small dialog image. 

2. Removed the Effects menu option. 

3. Replaced the "Image � Blur" menu with a Blur and Sharpen dialog. 

4. Now the edges of the image are not clipped when a Border is added to it, the image 
is resized to fit entirely within the border. 

5. Added "Object(s) � Selected Object(s) � Edit Free-Form Line/Shape" menu 
option.  Available only when a Free-Form Line or Shape object is selected. 

Image Batch Conversion 

1. Now it is possible to convert from 82 input formats to 36 output formats. 
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Version 1.3.1 – 18th November 2005 

Image Viewer 

1. The Batch Conversion dialog is now a separate window. 

2. Image Viewer now supports proprietary plug-ins. 

3. Image Viewer can now load, edit and SAVE 25 new image formats, as follows: 
PCD, CUT, AVS, CIN, DOT, DPX, FITS, FPX, HDF, MIFF, MTV, PALM, PCL, 
PICT, SGI, SUN, SVG, VICAR, VIFF, XBM, XCF, XPM, JBG, JBIG and BIE. 

4. Image Viewer can now load and edit 8 new image formats, as follows: DNG (RAW 
Digital NeGative format), DCM, DICOM, MAT, PIX, PWP, RLA and TTF. 

5. New "Tools" menu for Batch Conversion, Make Contact Sheets, Screen Capture 
and Acquire from Scanner menu options.  Moved from Options menu. 

6. The image Properties are now displayed in colors, to show General Properties in 
Red, Type Properties in Green, and EXIF Properties in Blue, all in separate blocks. 

7. RAW image color improvements. 

8. Added "Options � Use RAW Auto White Balance" menu option. 

9. Added "Mouse Action � Create Polygon from Edge" menu option. Click on a pixel 
in the image to define the start color. 

10. Added "Object(s) � Create an Object � Free Form Line" menu. 

11. Added "Object(s) � Selected Object(s) � Fit Text to Path" menu option.  To use 
select 1 Polygon OR Free Form Line object, plus 1 Text object ONLY. 
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Version 1.2.6 – 29th August 2005 

File Manager 

1. Fixed a bug in renaming a new folder when another folder is selected that caused 
wrong folder names. 

2. Fixed a bug in renaming a new folder on the Desktop, when the Desktop folder is 
selected, causing Xplorplus to end. 

3. Fixed a bug in deleting a folder in the Drive list. 

4. Image Viewer toolbar button tool tip now says "Image Viewer", not "Picture Viewer". 

5. Fixed a bug when Exiting the "Compare File Lists" dialog, after actually performing 
a compare, which caused a different sort sequence in the 2 file lists. 

6. Fixed a bug in Keyboard Shortcuts Help dialog. 

Image Contact Sheet Manager 

1. Enhancements added to increase image size, layout and rotation options. 

2. Now automatically senses folder changes and displays all or the selected image file 
counts for the folder. 

3. Improved speed when working with large (1 or 2 images across) images. 

4. When "Images Across" set to 1, all images are now resized to fit in the sheet. 

5. Added option to show or hide the headings. 

6. Now up to 4 times faster than Photoshop 7, especially when processing large 
images. 

7. Now does 1 to 12 images per row, 1 to 264 images per page. 

8. Added buttons to Print, Print Preview, or View the Selected Sheet. 

9. Added an option to use the last level part of the current folder name as the contact 
sheet heading and file name. 

10. Now it is NOT possible to change directories in Xplorplus (the File Manager) while 
the contact sheet is being created. 

11. Now there are 21 contact sheet size options, including A2 to A6, Super A3, CD and 
DVD Covers, B3 to B6, Letter and Legal, plus more. 

12. Now it is possible to hide the contact sheet during the build process to speed up 
building the images on to the sheet considerably, sometimes up to 20 times faster. 

13. Added options to add the Date and/or the Sheet Size to the end of the file name 
and Heading, to avoid overwriting previous files. 

Rename Multiple Files 

1. Added options to add a Custom date, or the File's Last Modified date in the New 
Name template. 

2. Fixed a bug using certain sequence numbers. 

3. Added an option to use the last level part of the current folder name in the rename 
template. 
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Thumb Viewer 

1. The "Thumbnails � Select All Thumbs" menu now selects all the image files in the 
file list, as well as in the Thumb Viewer. 

2. Added "Options � Show Non-Images as Blanks" menu to optionally indicated files 
selected in error.  Selecting this option turns off the "Auto-Refresh Thumbs on 
Folder Change" menu option. 

3. Added "STOP" menu to interrupt filling the Thumbnail Viewer. Menu is only visible 
during the filling process. 

4. Now De-Selecting a Thumb also De-Selects the associated file in the file list. 

5. Now removing the current image from the Show in "Show Selected" mode,  by 
pressing F10 or R, also De-Selects the associated file in the file list. 

6. Fixed a display bug again, where the progress-bar did not resize properly after the 
Thumb Viewer was minimized. 

7. Added "Options � Hide Images While Loading" to speed up the loading process, 
especially with large numbers of smaller images. 

8. Now, if the Thumb Viewer is minimized while it is loading images, it will re-display 
itself when finished. 

9. Now a warning message is displayed when attempting to Auto-Rotate a thumb that 
can NOT be rotated due to it's format, or if it is an EXIF Preview Image. 

10. Improved the quality of non-JPEG output images after rotation. 

Image Viewer 

1. Fixed a bug in Merging All Objects while a new object is still selected caused it to 
disappear.  Now you can only "Merge All" if NO objects are selected. 

2. Added "File � Print..." menu option for direct printing. 

3. Added "File � Print Setup..." menu option. 

4. Added "Options � Make Contact Sheet(s)..." menu option. 

5. Added "Settings � Auto-Adjust RAW Image Colors", to adjust the color of a RAW 
image using the EXIF Preview image colors. 

6. Added "Settings � Show EXIF Preview Image".  The Preview window is only 
visible if there is an EXIF preview. 

7. Now Clicking the mouse outside a Selection Cancels the selection. 

Image Batch Conversion 

1. Improved the quality of the JPEGs output. 

2. Fixed a bug that occurred when opening and resizing, while the Image Properties 
were showing. 

3. Now when an image file extension does not match the image format, an error 
message is displayed. 

4. Now you can enter a custom value in the Output size dropdown list. 

5. Now successfully converted images display as green in the file list. 
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6. Added a STOP button to interrupt the conversion process. 

7. Added all RAW types to the Input Type list box. 

Property Changer 

1. Improved the speed of changing multiple file extensions. 

IE Cache Manager 

1. Now ALL EXCEPT Protected Cookies are deleted if 'Clear All Cookies on Restart' 
is checked. (Previously ALL, including Protected cookies were deleted) 
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Version 1.2.5 – 10th July 2005 

File Manager 

1. There is now a new Tools menu option 'Contact Sheet Manager...'. 

Thumb Viewer 

1. There is now a new Thumbs menu option 'Make Contact Sheet(s)...' 

Image Contact Sheet Manager (New) 

1. This is a new window that lets you create image Contact Sheets (containing 
multiple arranged images) from the image files in a folder.  The sheets contain 2 
headings containing the date, file name, page number, folder name, and then the 
images.  Sheets can be created in either portrait or landscape orientation. Images 
can be arranged horizontally or vertically, showing from 1 to 8 images per row. 
Either all or the selected files can be used. There is also a 'test' mode that lets you 
work out the best layout for the number and size of the contact sheet pictures, 
without saving. 
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Version 1.2.4 – 30th June 2005 

File Manager 

1. There is now a new File menu option 'Rename Multiple Files...'. 

Rename Multiple Files (New) 

1. This is a new window that lets you change 1 or more files according to a 'mask' or 
'template'.  The mask includes a prefix and a suffix to the original filename each 
containing options for: 2 separate text positions, sequence numbers, todays date 
and time, or the file date and time.  The rename mask results can be previewed in a 
separate window before doing the final rename. 
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Version 1.2.3 – 25th June 2005 

Help - About Window 

1. Now shows the registered user name, or "Evaluation User" if not registered. 

File Manager 

1. Fixed a bug that stopped users registering after the trial period had expired. 

IE Cache Manager 

1. Enhanced the deletion of the IE History cache entries to also delete the actual 
Internet Explorer DISPLAYED list, if the "Select All" option is chosen. 

2. Now there is an option to delete ALL IE caches in one action, except for protected 
cookies. 

Thumb Viewer 

1. There is a new menu option on the ThumbViewer File menu: "Auto-Refresh on 
Folder Change" which allows you to turn this feature ON or OFF.   

2. When the above menu option is OFF you can now select multiple files in the file list 
then click on the ThumbViewer window and press Ctrl-R (Refresh Thumbs) to re-
populate the Viewer with only the selected file images.  Selecting only 1 file will 
cause the Viewer to populate with ALL file images in the folder. 

3. There is a new option while the Slide Show is playing, to Remove the current image 
from the Show if in "Show Selected" mode.  Press F10 or R to Remove the image.  
If in Continuous Play mode, the image will not be shown on the next loop. 

4. Fixed a display bug, where the progress-bar did not resize properly after the Thumb 
Viewer was minimized. 

Image Viewer 

1. Added the ability to read, display, edit and save RAW image types (but NOT Save 
as RAW). 

2. Now shows Digital Camera EXIF properties, if available. 

3. Added the option to save images as PS, EPS (PostScript) or PDF (Adobe Portable 
Document Format) file types. 

4. Now shows the Selection Width and Selection Height values while selecting part of 
an image.  The values temporarily replace the Actual Image Width and Height 
values displayed in the information area at the top of the image, and are shown 
with a light yellow background. 

5. Added menu option to Select from 1 of 11 preset area sizes from 320x200 to 
2048x1536 pixels, or type in a custom size. 

6. Added 4 new menu options (Settings � Rotation Sampling Method) to choose the 
resampling method to be used when rotating an image by 90, 180 or -90 degrees. 

7. Moved "Zoom Filter (Display Only)" and "Screen Size" menu options from "Options" 
to "Settings". 
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Version 1.2.2 – 12th April 2005 

IE Cache Manager (New) 

1. New feature implemented to delete the History and Temporary Internet File folders 
when the computer is restarted. Plus an option to refresh selected IE index.dat files 
(only available if the user actually logs on to Windows 2000/XP, not via the XP 
Welcome screen). 
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Version 1.2.1 – 11th April 2005 

Thumb Viewer 

1. Fixed a problem where rotating image files (not just the thumb image) stored on a 
CD or write-protected media created an error.  Now a dialog is displayed to say you 
can't do it. 

2. Improved the algorithm for rotating image files (not just the image). Now JPEGs are 
rotated using a Lossless algorithm and all other image types are rotated free of 
compression. 

Image Viewer 

1. Fixed a problem where switching between "Fit Image In Window" and "Show Print 
Size" and "Show Actual Pixels" didn't work properly. 

File Viewer 

1. Fixed a problem where the last block of a file was not displayed in Binary/Hex View, 
if it was less than 16 bytes long. 

File Manager 

1. Fixed a problem where the file and folder counts are incorrectly displayed on the 
status bar after certain operations. 

2. The Internet Explorer version is now displayed in the Quick System Information 
Viewer (double-click the status bar). 

 



 XplorPlus Changes 

Author and Copyright: Raysoft Systems Page 60 of 64 Date: 24 June 2010 

Version 1.1.13c – 31st March 2005 

File Manager 

1. Now there is a menu option to launch a program or open a folder using a single 
mouse click. (Accessiblity option for movement challenged people). 

Folder Report 

1. Now there are 8 (2^3) combinations of Folder Report layouts possible, including 
one with just file names. 
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Version 1.1.13b – 24th March 2005 

Thumb Viewer 

1. Now rotates selected thumbs properly and much faster if they are not rotating the 
actual image files. 

2. Now multiple image selections are visible as file selections in the main file list, to 
enable drag & drop operations. 

3. Now you can Select All Thumbs from a menu 

4. Now you can Copy Selected Thumbs to another folder. 

Image Viewer 

1. There is now a new interface for changing object properties interactively instead of 
through the menus.  This includes a real-time Text Effect dialog. 

2. There are now extra shapes and selection options. 
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Version 1.1.13 – 10th March 2005 

File Manager 

1. Sticky Moveable Columns, by dragging the header. 

2. Sticky Column Sorting, by clicking the header, or through a menu. 

3. New "Options" � "Select Item on Mouse-Hover" menu, with varying time settings 
(Accessiblity option for movement challenged people).  Unlike Explorer, it works in 
BOTH the File List and the FOLDER TREE, PLUS... it expands after a given time, 
then it selects the folder and displays it's contents in the file list after a second 
timed interval. 

4. Options - Watch Remote Folders menu (see Help) 

5. F2 (as well as the original Ctrl-R) to Rename a selected item. 

6. Updated Help file to cover the changes. 

7. Updated Shortcut Keys file. 

8. Remove need for Manifest Files. 

9. Now opens Maximised if it was closed Maximised. 

Image Viewer 

1. New Image Editor text effects 
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Version 1.1.12 – 6th March 2005 

File Manager 

1. A minor bug that could cause an abrupt termination has been fixed. This happened 
when there was an attempt to change the column view in a blank file pane. The 
pane will now populate with the contents of c:\ first. This did not seem to happen 
under XP, only Win 2000. 

2. A text find function has been added to the Help menu. This is accessed by using 
control-F. If help text is selected in the Help document before opening the Find 
dialog with Ctrl-F, the Textbox will contain the selected text, otherwise it will contain 
the last string entered. "Match Case" and "Whole Word" option settings are 
remembered between uses. OLE Drag and Drop is also possible from anywhere 
into the textbox. It has both Find and Find Next options. 

 



 XplorPlus Changes 

Author and Copyright: Raysoft Systems Page 64 of 64 Date: 24 June 2010 

Version 1.1.11 – 23rd February 2005 

File Manager 

1. Fixed - Printing files from Xplorplus, or Print Previewing images from Image or 
Thumb Viewers, caused Xplorplus to crash if no printer was installed. 

2. Added - Display Filter menu option (with 8 settings) to the Image Viewer to make 
zoomed images smoother to look at. 


